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Preface

Safety Notes

Your  WorkCentre and supplies have been  designed and tested to meet
strict safety requirements.  These include  safety agency examination and
approval and compliance to established environmental standards.  Please
read the following instructions carefully before operating the WorkCentre,
and refer to them as needed to ensure the continued safe operation of your
WorkCentre.

Follow all warnings and instructions marked on or supplied with the product.

Symbology:                 = Hight Voltage,                   = Warning

Unplug this WorkCentre from the wall outlet before cleaning.  Always use
materials specifically designated for this Workcentre.  Use of other materials
may result in poor performance and could create a hazardous situation.

Do not use aerosol cleaners.  Follow the instructions in this User Guide for
proper cleaning methods.  Always unplug from the electrical outlet prior to
cleaning.

Never use supplies or cleaning materials for purposes other than than for
which they were intended.  Keep all supplies and materials out of reach of
children.

Do not use the WorkCentre near water, wet locations, or outdoors.

Do not place the WorkCentre on an unstable cart, stand, or table.  The
WorkCentre may fall, causing personal injury or serious damage to the
WorkCentre.

This product is equipped with a 3-wire grounding type plug (e.g. plug having
a third grounding pin).  This plug will fit only into a grounding-type power
outlet.  This is a safety feature.  To avoid risk of electric shock, contact your
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electrician to replace the receptable if you are unable to insert the plug into
the outlet.  Never use a grounding adapter plug to connect the WorkCentre to
a power source receptacle that lacks a ground connection terminal.

This WorkCentre should be operated from the tyope of power source
indicated on the marking label.  If you are not sure of the type of power
available, consult your local power company.

Do not allow anything to rest on the power cord.  Do not locate the
WorkCentre where persons will step on the cord.

The ON/OFF switch does not electrically disconnect the machine from the
power supply.  The power supply cord is the disconnect device for this
equipment.  Ensure that installation is near the outlet and is easily
accessible.

Your machine is equipped with an energy device to conserve power when
the machine is not in use. The machine may be left on continuously.
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Safety Notes (continued)
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Safety Notes (continued)

Electricity at Work Regulation (in England and Wales) UK ONLY

Electricity at Work Regulations:

The Electricity at Work Regulation 1989 came into force in England and
Wales on the 1 April 1990.  This 1989 Regulation places a duty on all
employers and self-employed persons to ensure the electrical system in their
premises are constructed, maintained and operated in such a manner as to
prevent, so far as reasonably practical, danger.  This includes ensuring all
electrical equipment connected to such electrical systems are safely
constructed, maintained and operated.

All Xerox equipment have been designed to exacting safety standards.  They
have all undergone a variety of stringent safety tests including earth bond,
insulation resistance and electrical strength tests.  Xerox Europe
manufacturing plants have been awarded ISO 9000 quality certification and
are subject to regular audits by the British Standards Institution or equivalent
national standards body.  Xerox equipment which has been properly and
regularly serviced and maintained should not have to undergo additional
specific safety tests pursuant to the 1989 Regulation.  Customers wishing to
complete safety testing should contact Xerox Europe Technical Centre (see
page 1) for advice prior to any test implementation.

Xeros equipment should, however, be properly and regularly serviced and
maintained at all times.
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Helpful Hints

Care of Your WorkCentre
Q Avoid removing the ink jet cartridges from the WorkCentre unless they

are to be replaced.Do not place heavy objects on any surface of the
WorkCentre.Take care not to place liquids on or near the WorkCentre
surface.Avoid placing clips or staples on any WorkCentre surface.

Maintenance
Q Clean the Document Glass daily and as required.

Q Do not apply cleaning liquids or sprays directly to the WorkCentre; apply
to the cloth first.

Q Store paper in a dry area, on a flat surface and in a closed cabinet.

Q Wrap partially used reams of media tightly.

WorkCentre Location
For reliable WorkCentre operation and copy quality, Xerox recommends:

Q Place your WorkCentre in a well-ventilated room, positioning it so that
you do not block any ventilation slots or openings, as described in the
safety notes.

Q Recommended environment:

� Temperature: 60o to 90o F (15o to 32o C.

� Humidity: 40% to 70%.

Q Place the WorkCentre on a flat, level surface.

Q Avoid locations that subject the WorkCentre to:

� Direct Sunlight.

� Extreme changes in temperature or humidity.
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 Supplies

Visit the Xerox Web site at http://www.xerox.com for additional product
information.

Supplies
To order supplies for your WorkCentre, call or visit your local retailer

Part Numbers for Consumables:

Black Ink Cartridge:  8R7881

Color Ink Cartridge:  8R12591

CAUTION: Non-Xerox ink cartridges will not fit correctly into the
WorkCentre cartridge compartment, and may damage the machine.
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System Requirements
Proper operation of the WorkCentre for printing  and scanning requires that
your PC meets or exceeds the following system requirements:

Q IBM compatible personal computer:

O Minimum configuration: 486DX, 200MHz, 16 MB RAM, 20 MB free
hard disk space*, Windows 3.1x

O Recommended configuration: Pentium II, 200MHz, 32 MB RAM,
20 MB free hard disk space*, Windows 3.1x

Q Windows® operating environment (Windows® 3.1x, Windows® 95,
Windows® 98, Windows® NT 4.0)

Q 16 MB or more RAM (Windows® 3.1x), 32 MB RAM (Windows® 95, 98),
and 32 MB RAM (Windows® NT 4.0)

Q A USB cable is supplied for printing and scanning functions. If you do not
have a USB port on your PC and you want printing and scanning
functions, you must supply an IEEE 1284 bi-directional parallel cable,
maximum 6 feet/2 metres.

* 20 MB minimum hard disk space required for driver installation only. If
installing the additional software, an additional 90MB free hard disk
space is required (70MB for Pagis Pro®, 20MB for MGI PhotoSuite®).

Xerox provides a print driver, TWAIN scanner driver and Control
Program (for ink cartridge management). Pagis Pro and MGI PhotoSuite
are provided if you do not already have a scanner/image editor program;
these two software applications require Windows 95/98 or NT 4.0.
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1.  Getting Started

This section describes the installation and setup of your WorkCentre. The
following topics are included:

Page
Components .....................................................................2
Control Locations ..............................................................3
Control Panel ....................................................................5
Setup ................................................................................8
Installing & Aligning Ink Cartridges.................................. 11
Using the Automatic Paper Feeder (APF) ....................... 14

Loading Paper ..................................................................... 14
Loading Envelopes ......................................................... 15
Using the  Paper Tray ..................................................... 16
Using the Menu Button.................................................... 17

Changing Ink Cartridges...................................................... 17
Aligning Ink Cartridges ........................................................ 17
Setting Paper Size Using the Control Panel ....................... 18
Testing the Print Nozzles .................................................... 18

Paper Guidelines ............................................................ 19
Paper Selection ................................................................... 20
Guidelines for Special Paper and other Media.................... 21
Transparencies and glossy photo paper ............................. 21

Installing Software........................................................... 22
Overview of WorkCentre Software ...................................... 22
General Installation.............................................................. 23

Uninstalling Software ...................................................... 24
Windows® 3.1x .................................................................... 24
Windows® 95/98, or Windows® NT...................................... 24
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2 Getting Started

Components

The following components are provided with your WorkCentre. Please
examine the carton contents. If any component is missing, contactyour local
Helpline.

Set of CD-ROMs AC Power cord USB cable

NOTE: The black ink cartridge that is initially supplied with the WorkCentre is
a standard capacity cartridge. This initial black cartridge may run out of ink
before the Low Ink Diagnostic Display turns on. Replacement black
cartridges (#8R7881) are higher capacity.

Documentation:
Q User Guide
Q Warranty
Registration

Q Quick Reference
Card

Ink cartridges:
Q Color #8R12591
Q Black #8R7881

Q Warranty
Registration Card

WorkCentre
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Getting Started 3

Control Locations

Familiarise yourself with the machine’s components and controls and their
locations.

 Paper tray extension

Platen cover

Scanner module

Control Panel

Display

Output tray extension

Extender

 Paper tray extension

 Paper tray

 Automatic Paper Feeder side paper guide

Manual Paper Feeder guide

Manual Paper Feeder

Automatic Paper Feeder envelope guide
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4 Getting Started

Control Locations (continued)

Scanner module

Cartridge compartment lid/support

Ink cartridge  access

Control Panel

Lower left back of machine

Spare ink cartridge compartment

AC power cord socket

Lower right back of machine

On/Off switch

USB port

IEEE 1284 Parallel port
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Getting Started 5

Control Panel

Use the following graphic to locate the buttons, and display on the
WorkCentre Control Panel.

1  Resolution Press to select the print resolution.

Best Normal Draft

2  Contrast Press to lighten or darken the image.

Lighten Normal Darken.

3  Media Type Press to choose the media type to be used.

Transparencies

Glossy paper

Coated paper

Plain paper �

 9  10  11  12  13

 1  2  3  4  5  6  7  8
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6 Getting Started

4  Special Copy Press to set an option.

Fits multiple copies on one sheet (clone).

Auto Reduces or enlarges the original to fit paper size.

100% Makes a copy the same size as the original.

5  Copy Size/Scroll Press and hold one of these two buttons to reduce
or enlarge the copy size from 25% to 400% of the
original document in 1% increments. Also used to
scroll through the menu choices as shown in the
Display.

6  Diagnostic Lights up when colour cartridge ink level is low.
Display
LEDs Lights up when black cartridge ink level is low.

Lights up when a paper jam occurs or the paper
feeder is empty.

7  Number of Copies Press to set the number of copies from 1 to 50.

8  B&W/Color Mode Press to select between black and white mode and
color mode.

Black and white mode

Colour mode

9  Percent button Press to change the Display. When this % light is
on, the Display shows the current copy size. When
the LED light is off, the Display shows the current
status of the machine.

10  Display Used to display machine status, copy size, menu
codes and error codes.

�
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Getting Started 7

11  Menu Press this button to enter Menu Mode. Each time
you press this button, the Display shows the menu
code:

  U01  Change cartridges

  U02  Align cartridges

  U03  Set paper size

  U04  Ink nozzle self test/cleaning

12  Start Press to start operation or activate your selection.

13  Stop/Cancel Press to stop an operation or cancel a selection.
This action restores all copy menus to default
settings in standby mode.
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8 Getting Started

Setup

Use the following procedure to initially set up your WorkCentre.

1 Open the shipping carton on a flat, stable surface. Remove all packing
materials and components. Check the set of components with the
component list. If any components are missing, callyour local Helpline.

2 Remove the wrapping from the machine, and place the machine in its
work location. To help guarantee trouble-free operation of your machine,
place it on a flat, stable surface near yourPC.  Leave enough space to
allow for easy paper loading, paper unloading, and opening of the front
cover.

NOTE: Do not place your machine:

XX In direct sunlight.
XX Near heat sources or air conditioners.
XX In dusty or dirty environments.

3 Carefully remove the shipping tapes from the machine: the paper exit
tray in the front bottom area, both top sides and the paper feeder tray in
the back of the machine.

Paper exit tray Top side Paper feeder tray

4 Pull the extension tray upwards out of the Automatic Paper Feeder until
it clicks into place. Also pull the paper exit tray outward from the front
base of the machine. Fold out the extender from the paper exit tray
when copying or printing.

�
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Getting Started 9

5 Attach a printer cable.

Q USB cable (only for Windows 98 PCs): Plug one end into the USB
port on the back of the WorkCentre, and the other end into the USB
port on your PC.

Or

Q Parallel cable (not supplied, use IEEE 1284 cable for bi-directional
communications): Plug one end of the parallel cable into the
matching parallel port on the back of the WorkCentre, and plug the
other end into the matching parallel port on your PC. Swing the two
wire clips on the sides of the WorkCentre parallel port inward until
they lock firmly inside the notches on the parallel cable connector.
Refer to your computer documentation for assistance with this
parallel cable procedure.

CAUTION: Use only one cable – USB or parallel cable. If your PC
does not have both a USB port and Windows 98, you must use a
parallel cable.

Wire clip Parallel port USB port

6 Plug one end of the AC power cord into the power socket on the back of
the machine. Plug the other end into a standard AC power outlet.

AC power cord socket

�
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10 Getting Started

Setup (continued)

7 Turn the WorkCentre power switch on. The switch is located on the rear
of the machine, next to the printer ports. Pressing the right, outer side
turns the power on; pressing the left, inner side turns the power off.

Power switch

8 The Control Panel Display will show   000   in a scrolling manner while
the machine is initializing.

9 The Display will show   001   when it is ready for use. Control Panel
mode indicators are set to default values for this setup procedure. When
you first power the machine on and there are no cartridges installed, you
will see the error code   E02   shown in the Display. This means there is
no left (color) cartridge installed. This error code will disappear when you
start the next procedure.

10 Proceed to the next step Installing & Aligning Ink Cartridges.
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Installing & Aligning Ink Cartridges

The WorkCentre is a dual cartridge inkjet printer.  You must use a black ink
cartridge and a color ink cartridge.  When viewed from the front of the
machine, the color ink cartridge is installed in the left cartridge holder and the
black ink cartridge is installed in the right cartridge holder. Use the following
procedure to install the two ink cartridges and align them.

When installing ink cartridges, you must provide specific information to the
WorkCentre about the cartridges you install. This allows the printer to monitor
ink cartridge utilization.

There are two methods of entering cartridge information.

Q Using the WorkCentre Control Panel buttons

Q Using the WorkCentre Control Program software and a PC

The procedures in this section describe ink cartridge installation without
using the WorkCentre Control Program. To install ink cartridges using the
WorkCentre Control Program, see Section 5 Maintenance/Control Program.

1 Load sheets of paper (A4) into the Automatic
Paper Feeder against the right edge of the
paper feeder. Squeeze the side paper guide
with two fingers to release the guide, and slide
the guide all the way to the left side of the paper
tray.

Ensure that the guide is against the left edge of
the paper. For best results, use high quality xerographic copy paper or
inkjet paper.

2 Open the entire scanner module (not just the document cover) by lifting
the front edge upwards.

3 Support the scanner module by lifting the cartridge compartment
lid/support up so the scanner module rests on the top edge of the
lid/support.

4 Press the Menu button. A   U01   message will appear in the Display.
Press Start. The cartridge holder will move left to the open change area.
The   L-C   message (left cartridge) will appear.

�
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12 Getting Started

Installing & Aligning the Ink Cartridges (continued)

5 Unpack the black ink cartridge. Remove the sealing tape.

NOTE: Hold the cartridge carefully. Do not
touch the electrical contacts on the side and
bottom of the cartridge. Ensure that there are
no pieces of tape remaining on the cartridge.

6 Insert the black cartridge down into the
cartridge holder on the right side of the carrier assembly. Push the
cartridge toward the back of the machine until it snaps into place.

7 Unpack the colour ink cartridge. Remove the sealing tape.

8 Insert the colour cartridge down into the
cartridge holder on the left side of the carrier
assembly. Push it toward the back of the
machine until it clicks into place.

9 Close the cartridge compartment
cover/support and scanner module.

10 The   L-C   message (left cartridge) still appears in the Display. Press
Start to indicate you have just installed the color ink cartridge in the left
cartridge holder. Pressing Stop indicates that a new color ink cartridge
was not installed (this avoids the alignment procedure).

11 The   r-C   message (right cartridge) will appear in the Display. Press
Start to indicate you have just installed the black Ink cartridge in the right
cartridge holder. Pressing Stop indicates that a new black Ink cartridge
was not installed (this avoids the alignment procedure).

�
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Installing & Aligning the Ink Cartridges (continued)

12 If you pressed Start to either of the two messages, the alignment
procedure will start. An alignment test pattern sheet will print during
which time the Display will show   L-P  . Review this sheet in response
to the next series of six messages. See an illustration of the alignment
sheet in Section 5 Maintenance/Cartridge Alignment.

13 For the first alignment message, the Display will show “A” plus a number,
as,   A15  . Look this number up on the alignment sheet. If the printed
lines associated with this number are aligned better than any of the other
printed lines in group “A”, press Start. If there is another set of printed
lines that are aligned better, press the appropriate Copy Size/Scroll
button until the number associated with the best-aligned set appears in
the Display. Press Start.

NOTE: The machine will time out after one minute if Start is not pressed,
and will return to Standby Mode. The Display will then show   001  .
Press Menu repeatedly until you see the code   U02   displayed, then
press Start to repeat the cartridge alignment process.

14 The Display will show the next alignment message in the series. Repeat
step 13 for these remaining five steps, from “B” through “F”.

15 The Ink Cartridge alignment is completed. Proceed to the next section
Using the Automatic Paper Feeder.
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14 Getting Started

Using the Automatic Paper Feeder (APF)

Loading Paper
You can load paper, envelopes, card stocks, labels, or transparencies in the
Automatic Paper Feeder. If there is no paper loaded and you attempt to copy
or print, the error message   E01   will appear in the Display. The Automatic
Paper Feeder can hold a maximum of 100 sheets of plain paper, or 10
envelopes or other print media.  Depending upon media thickness, maximum
capacity may be reduced.

NOTE: If you experience problems feeding any media in the Automatic Paper
Feeder, place the media into the Manual Paper Feeder one sheet at a time.

1 Pull the Extension Tray on the Automatic Paper Feeder all the way up
until it clicks into place.

2 Prepare the print material for loading. For paper, flex paper back and
forth. For transparencies, fan the stack to prevent feeding failures. Do
not fold or crease the paper. Straighten the edges on a level surface.

NOTE: For transparencies, be sure to use transparency stock approved
for use with inkjet printers. Refer to the packaging for the transparency
stock to determine the print side. Hold the transparencies by the edges
and avoid touching the print side. Be careful not to scratch or leave
fingerprints on the print side.

3 Load the sheets in the Automatic Paper Feeder. It is located behind the
Manual Paper Feeder. Ensure that the right edge of the media is in
contact with the right side of the feeder. Do not exceed the rated
capacity. Do not mix different types of print media. Refer to the following
instructions for loading each type of print material.

Q Load paper or transparencies with the print side facing you.

Q Load letterhead paper with the design side facing you.  The top edge
of the sheet with the logo should enter the printer first.

Q Load drilled paper with the hole punches on the left side when
printing in landscape orientation or right side (portrait orientation) and
the print side facing you.

�
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Using the Automatic Paper Feeder/Loading (continued)

4 Move the side paper guide to the right while squeezing the tab on the
side paper guide.  Slide the side paper guide until it lightly touches the
side of the print media.

NOTE: Do not press the guide too tightly to the edge of the print media.
The guide may bend the media or prevent the media from feeding.

5 When you print a file from your PC using the Automatic Paper Feeder,
make sure that you select the source and the correct paper size from
your PC software application before starting your print job. You can also
set paper size at the Control Panel.

Loading Envelopes
When printing envelopes, remember to use
the envelope guide in the Automatic Paper
Feeder.

To load envelopes:

1 Pull the envelope guide out towards you
until it snaps into place at a right angle
to the paper tray.

2 Load envelopes with the address side facing you. The end of the
envelope with the stamp area must enter the feeder first.  The right edge
of the envelope must align with the raised edge of the envelope guide.

3 Squeeze the side paper guide and move it to the right until it lightly
touches the envelopes.

NOTE: If envelopes jam while printing, try reducing the number of envelopes
in the Automatic Paper Feeder. Fan the envelopes back and forth.

CAUTION: Do not feed stamped envelopes. Never use envelopes with
clasps, snaps, windows, coated linings, or self-stick adhesives.  These
envelopes may severely damage the printer.
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16 Getting Started

Using the  Paper Tray

The Manual Paper Feeder is located in front of the Automatic Paper Feeder.
Use the Manual Paper Feeder to feed paper one sheet at a time into your
machine.

When you print a file from your PC using the Manual Paper Feeder, ensure
that you select the source and the correct paper size from the Control Panel
or your PC software application before starting your print job.

1 Place the paper in the Manual Paper Feeder and adjust the Manual
Paper Feeder guide to the width of the print material.

2 Slide the guide to the right until it lightly touches the left edge of the print
media.

NOTE: Do not press the guide too tightly to the edge of the print media.
The guide may bend the media or prevent the media from feeding.

3 Ensure that the media is fed into the machine as far as it will go.
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Using the Menu Button

The Menu button (located to the right of the Control Panel Display) is used
for ink cartridge functions. Each function is associated with a message code
starting with the letter “U”.

When you first press the Menu button, you will see the code   U01  .
Repeated pressing of the Menu button will cycle through the codes. When
you select the function you want, press Start to begin the procedure. The
functions are:

  U01  ..Changing cartridge

  U02  ..Aligning the ink cartridges

  U03  ..Setting paper size

  U04  ..Ink nozzle self test/cleaning

NOTE: During any Menu operation, if you do not take any action (press any
buttons) for one minute, the machine will return to standby mode. The
Display will then show   001  .

Changing Ink Cartridges

Press the Menu button until you see the code   U01  . See Installing &
Aligning Ink Cartridges earlier in this section or Section 5
Maintenance/Replacing Ink Cartridges for details.

Aligning Ink Cartridges

Press the Menu button repeatedly until you see the code   U02  . See
Installing & Aligning Ink Cartridges earlier in this section or Section 5
Maintenance/Aligning Ink Cartridges for details.
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Setting Paper Size Using the Control Panel
You can load A4, letter or legal-sized paper. Your WorkCentre is preset to A4
size. If you load letter or legal-sized paper, you must set the machine to the
correct paper size.

1 Press the Menu button on the Control Panel repeatedly until   U03   is
shown in the Display.

2 Press Start.   P01   is displayed (A4size).

3 If necessary, press one of the Scroll buttons to choose either   P02   for
letterpaper or   P03   for legal-sized paper.

4 Press Start to confirm the new setting.

Display Paper Size

  P01  .   A4

  P02  . Letter

  P03  . Legal

Testing the Print Nozzles

Press the Menu button repeatedly until you see the code   U04  . See
Section 5 Maintenance/Clean Print Head Procedure for details.
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Paper Guidelines

When selecting or loading paper, envelopes or other special media, keep
these guidelines in mind:

Q Attempting to print on damp, curled, wrinkled or torn paper can cause
paper jams and poor print quality.

Q Use only high quality, inkjet-grade paper.  Avoid paper with embossed
lettering, perforations or texture that is too smooth or rough.

Q Store paper in its ream wrapper until ready to use.  Place cartons on
pallets or shelves, not on the floor.  Do not place heavy objects on top of
the paper, whether it is packaged or unpackaged.  Keep it away from
moisture, or other conditions that can cause it to wrinkle or curl.

Q Moisture-proof wrap (any plastic container or bag) should be used during
storage to prevent dust and moisture from contaminating your paper.

Q Always use paper and other media that conform to those listed under
Specifications in the Appendix.

Q Use only well constructed envelopes with sharp, well creased folds.

O DO NOT use envelopes with clasps and snaps.

O DO NOT use envelopes with windows, coated linings, self-stick
adhesives or other synthetic materials.

O DO NOT use damaged or poorly made envelopes.
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Paper Selection
One of the most important things you can do to assure the best possible
printing performance of your machine is to select the correct paper.  Your
machine produces letter quality print on most plain bond papers, including
cotton bond and photocopying papers; it does not require special ink jet
papers.  However, the print quality varies with different paper types.  Be sure
to test a type of paper before you purchase a large quantity.

Plain Paper

The machine supports paper sizes of letter, legal and A4 in portrait
orientation. You can use regular copier paper, cotton bond papers and typical
letterhead.  Always use paper without curls, folds, staples or damaged
edges.

Inkjet Paper

This paper has been developed specifically for printing with inkjet printers.  It
will produce high quality documents that compare favorably to those
produced with a laser printer.

Coated Paper

The coated paper has been developed for high quality printing with minimal
or no smearing or running when in contact with water or damp surfaces,
making it a good choice for damp or rainy environments.

Glossy Photo Paper

Glossy photo paper is a high gloss, thicker paper that produces the look and
feel of a photograph.  Use this paper to produce photo-realistic prints.

Transparencies

Your transparencies will possess excellent contrast, sharpness and colour.

Iron-on Transfers

Use inkjet T-shirt transfer paper to create and personalize T-shirts,
sweatshirts, aprons, tablecloths, napkins,etc.  Use on any cotton or
cotton/poly blend fabric. Follow instructions that come with the transfer
paper.

Greeting Card Stock

Get the most out of card making software with Greeting Cards.  These cards
give your unique, personalized cards the look and feel of professional cards.
You can create cards, invitations, announcements and more.

Download from Www.Somanuals.com. All Manuals Search And Download.



Getting Started 21

Guidelines for Special Paper and other Media
Be sure to read any instructions that come with your special paper.  These
instructions provide important information regarding how to achieve the
highest print quality with these papers.

Q It is recommended that you feed special paper types one sheet at a time.

Q Store unused media flat.  Do not remove papers from their protective
packaging until you are ready to use them.

Q Store unused media at temperatures between 59 and 86 degrees
Fahrenheit (15 to 30 degrees Centigrade).  The relative humidity should
be between 10% and 70%.

Q If the print density of your page is very high, light paper stock may curl
slightly due to the large amount of ink.  If you need to print dense
graphics, try printing on heavier stock.

Q Do not use thicker paper than meets the specifications for this machine.
Printing with a paper that is thick enough to come in contact with the print
head nozzles may damage the cartridge.

Transparencies and glossy photo paper
Q Let the printed sheets dry completely before storing them.

Q When a printed sheet has dried completely, cover the printed side with a
sheet of plain (not coated) paper before storing it; this is recommended
even if you place the sheets in a clear file or plastic holder.

Q Do not leave the sheets in the paper tray for long periods of time.  Dust
and dirt may accumulate on the sheets resulting in spotty printing.

Q To avoid smudging caused by fingerprints, handle transparencies and
glossy photo paper carefully.

Q To avoid fading, do not expose the printed sheets to prolonged sunlight.
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Installing Software

Overview of WorkCentre Software
Before the WorkCentre can work with your computer, you must install print
and scanner driver files.  These drivers will enable your computer to properly
communicate with the WorkCentre for printing and scanning operations.

All of the necessary print drivers are contained on the Xerox CD-ROM
included with your WorkCentre.

Also included on the Xerox CD-ROM is the WorkCentre Control Program.
This program helps to manage the WorkCentre machine. See Section 5
Maintenance/Xerox WorkCentre Control Program.

In addition to the Xerox software, two optional software applications are
included on separate CD-ROMs. These two applications work with Windows®

95/98/NT 4.0, but not with Windows® 3.1X.

Q Pagis Pro® 2.0 - a suite of scanning applications. See Pagis Pro
documentation on the Pagis Pro 2.0 CD-ROM or Pagis Pro online Help
for details. You will need to install Pagis Pro using the setup.exe file on
the Pagis Pro CD-ROM if you do not have a scanning program installed
on your PC capable of using the XK35c scanner driver. See Section 3
Scanning.

Q MGI PhotoSuite® - a suite of graphics processing tools. See MGI
PhotoSuite documentation on the MGI PhotoSuite CD-ROM or MGI
PhotoSuite online Help for details. You can use this software for editing
any images scanned by the XK35c. You can install this software using
the setup.exe file on the MGI PhotoSuite CD-ROM.

When you complete the Xerox software installation, the following items will
be installed on your PC:

Q Print driver for printing

Q TWAIN driver for scanning

Q Control Program for managing the WorkCentre

NOTE: When you install this software, make sure no other programs are
running.
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General Installation

1 Make sure the WorkCentre is connected to your PC.

2 Power on the WorkCentre.

3 Turn on your PC and start Windows.

4 Insert the WorkCentre CD-ROM into your CD ROM drive.

Installation for Windows® 3.1X continued…

5 From the File menu of the Windows Program Manager, select File>Run.

6 Type d:\Xinstall.exe (replace "d" with the letter designation of your PC’s
CD-ROM drive), and if necessary,click OK. Continue with step 7.

Installation for Windows® 95/98 or Windows® NT 4.0 continued…

NOTE: For USB (Windows 98 only):

a) You will see an Add New Hardware dialog. Select NEXT.

b) Follow screen instructions to load USB driver. When asked for USB
driver source, point to Xerox CD. Continue with screen instructions.

c) Go to Step 5 to manually install the XK Series printer and TWAIN
drivers.

5 If AutoPlay is not enabled to automatically recognize the CD-ROM,
select Start>Run (Windows 95/98 and NT 4.0).

6 Type d:\Xinstall.exe (replace "d" with the letter designation of your PC’s
CD-ROM drive), and if necessary, click OK. Continue with step 7.

General Installation continued…

7 The WorkCentre software installation program will begin. Follow the on-
screen instructions for the rest of the installation.

8 Restart your PC to complete the installation process.
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Uninstalling Software

To remove the Xerox-supplied software from your PC:

Windows® 3.1x

� In Windows 3.1x, all WorkCentre software components are installed into
a single program group.

� Start Windows 3.1x.

� In the Program Manager, double click on the WorkCentre XK Series
Program Group.

� The WorkCentre Program Group will open.

� Double click on the Program Group containing the component you wish
to uninstall.

� The Program Group will open.

� Double Click on the Uninstall icon.

� The selected component is uninstalled.

Windows® 95/98, or Windows® NT

� Start Windows.

� Select Start > Programs.

� Locate the Start Menu Program Item for the component you wish to
uninstall.

� Click on the Submenu Uninstall icon for the component you wish to
remove.

� A window will open prompting you to confirm that you wish to remove the
selected application.

� Click Yes.

� Uninstall Shield launches and the component is uninstalled.

� Each software component must be uninstalled one at a time.
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2.  Printing

This section describes printing from your PC to your Xerox WorkCentre. It
includes the following topics:

Page

Printing a Document From an Application ....................... 26
Printer Settings ............................................................... 27

Windows 95/98 and 3.1x Printer Settings ........................... 28
Windows NT 4.0 Printer Settings ........................................ 28
Printer Properties Tabs ....................................................... 29
Printer Properties Buttons & Icons ...................................... 29
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Printing a Document From an Application

This procedure describes the general steps required for printing from various
Windows applications.  The exact steps for printing a document may vary
depending on the application program you are using.  Refer to your software
application’s documentation for the exact printing procedure.

The following steps describe the typical process to print from a Windows
environment:

1 Ensure that your WorkCentre is properly connected to the computer, the
machine is powered on, there is paper in one of the paper feeders and
the Display shows the message   001  .

2 Verify that you have installed the print driver software for your machine.
See Installing Software.

3 Start the program you are using to create the document, and create or
open the document you want to print.

4 Choose Print or Print Setup from the File menu.  Make sure the
WorkCentre is selected as your default printer.  Click Properties or
Setup if you want to make any adjustments that are appropriate for
printing your document.  (See Printer Settings)

5 Click OK to close the Properties dialog box.

6 After making any necessary changes to the printing parameters, click OK
to start the print job.

7 During the printing process, the WorkCentre Display will show the
message   PCP  , and the WorkCentre Control Program tab menu will
appear on your PC screen showing printing progress.

NOTE: The WorkCentre supports DOS printing when the DOS application is
run within the control of the Windows MS/DOS dialog. See Section 5
Maintenance/Xerox WorkCentre Control Program for more information.
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Printer Settings

You can use your machine with all your Windows 3.1x, Windows 95/98 or
Windows NT 4.0 applications.  Be sure to set the WorkCentre as the default
printer for all your Windows operations.

Most Windows software applications allow you to make changes to the
printer settings.  This includes settings that determine how a print job looks
such as page size, paper orientation, and margins.  Settings made in the
application to create the document will usually override settings made in the
printer driver.

All screen captures for the following section are from the Windows 95/98
environment.

NOTE: You do not need to use any of the Control Panel buttons to use the
machine as a PC printer. For example, if you are printing a colour document,
you do not have to press the Colour button on the Control Panel. The Control
Panel buttons are used primarily for copying.
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Windows 95/98 and 3.1x Printer Settings
You can access printer settings by using either of these methods:

Q Select the File>Print>Properties or File>Print Setup command from
within any Windows application.  This method will provide access to the
Job Finishing, Paper, Document/Quality and Advanced tabs.

Or

Q Select the Xerox WorkCentre printer from the Printers folder, then select
File>Properties (or select the printer icon in the Printers folder, and click
the right mouse button).  This method will provide access to the General
and Details tabs, as well as the Job Finishing, Page, Main, and
Advanced tabs.

NOTE: Windows 98 also shows the Colour Management tab.

NOTE: In Windows 3.1x: Go into Print Manager and select the Xerox
WorkCentre printer; pull down the Options menu and select Printer
Setup. Click the Setup button to view the Page, Main, and Advanced
tabs.

Windows NT 4.0 Printer Settings
The Windows NT 4.0 printer drivers contain many of the same features as
the printer drivers for Windows 3.1 and Windows 95/98. However, the names
of the tabs and some of the features are different.

You can access the various printer settings by using either of these methods:

Q Select File>Print>Properties or File>Print Setup command from within
any Windows application.  This provides access to the Page Setup,
Color, and Features tabs.

Or

Q Select Xerox WorkCentre XK Series printer from the Printers folder,
click the right mouse button, then select Document Defaults from the
drop-down list.  This provides access to the Page Setup, Advanced, and
Cartridges tabs.
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Printer Properties Tabs

When the Printer Properties are displayed, you can review and change
whatever settings are needed for your print job.  If accessed through the
Printers folder, the Printer Properties Tab Menu consists of six tabs (seven
for Windows 98):

Q General tab - for viewing and changing general Windows 95 printer
information.  See your Windows 95/98 User Guide for details.

Q Details tab - for viewing and changing port and timeout parameters.  See
your Windows 95/98 User Guide for details.

Q Colour Management tab - for adding and removing colour profiles
associated with your printer.  This tab is , only shown in Windows 98.

Q Job Finishing tab – for settings Finishing options of booklet, poster,
handout or two-sided printing.

Q Paper tab - for paper sources and sizes, number of copies, and
orientation.

Q Document/Quality tab - for document and paper types and for print
quality.

Q Advanced tab - this tab provides access to controls for print image
quality.

Printer Properties Buttons & Icons
Q Click OK when done reviewing or making changes.

Q Click Cancel if you want to exit the tab menus without applying any
changes.

Q Click Help to view the online Help feature and tab menu details.

Q Click the ? icon in the tab dialog menu bar. Position the ? pointer over
the parameter in question and click to see a pop up window explaining
that parameter.

Q Click the Defaults button to reset the parameter values for all tabs to
their default settings (i.e., before you made any pending changes).

Q Click the About button to view the date and version of the print driver
software.

Download from Www.Somanuals.com. All Manuals Search And Download.



30 Printing

This page intentionally left blank.

Download from Www.Somanuals.com. All Manuals Search And Download.



Xerox Series User Guide 31

3.  Scanning

This section describes scanning with the Xerox WorkCentre XK35c. The
following topics are included:

Page
Scanning......................................................................... 32
Starting the Scan Process............................................... 32
Scanner Tab Menus........................................................ 34

Tab Menu Image Window ................................................... 34
Using the Tab Menus .......................................................... 34

Download from Www.Somanuals.com. All Manuals Search And Download.



32 Scanning

Scanning

You can scan a document with the XK35c. When you installed the XK35c
software, the TWAIN driver was also installed. By using a scanning program,
such as Pagis Pro (supplied by Xerox on a separate CD-ROM), you can use
the XK35c scan function.

While every scanning program is different, follow the basic steps outlined
here to invoke the scanner driver tab menus.

Starting the Scan Process

To start the scanning process:

1 Ensure that your WorkCentre is properly connected to the computer, the
machine is powered on and the Display shows the message   001  .

2 Verify that you have installed the TWAIN driver software for your
machine. See Installing Software.

3 With your PC and Windows running, start your scan program. You may
have the program represented on your desktop with an icon, or it may be
accessed by selecting Start>Programs>[program name].

4 Select File>Acquire or Acquire Image>Select Source in the File menu
to bring up a list dialog. Select Xerox WorkCentre XK Series, then
select OK. If the Acquire command is not available, you will need to use
another scan program. The Pagis Pro software program provides an
Acquire function.

5 Select File>Acquire Image >Acquire to invoke the XK35c scanner
driver.

�
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6 Lift the platen cover, and place your
document on the document glass.

7 Once you have invoked the scanner
driver, the tab menu will be
displayed. Click the Scan button in
the tab menu to start the scan
process. When the scanning process
begins, the WorkCentre Display will
show the message   PCS  .

NOTE: If the scanning process does not begin, try lowering the
resolution rate in the tab menu, and repeat the scan step.

8 Once you have generated a scanned image, you can edit the image
using the image editor functions (e.g., MGI PhotoSuite), or print the
image using the Print function in the scanning program, or save the
image to disk using a function such as Save As in the scanning program.

NOTE:: If you do not close the platen cover or the document is not evenly in
contact with the document glass, scanning quality will be severely reduced.
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Scanner Tab Menus

Tab Menu Image Window
The Tab Menu displays an image window on the right half of the dialog
window. This image window has ruler reference lines for editing. The left half
of the dialog window contains the four tab menus and their parameters.

To scan, click the Scan button in the lower right corner of the tab menu.

Using the Tab Menus
The Basic Tab Menu is the first of the scanning driver tab menus, and
provides the features of:

Q Image Type

Q Resolution

Q Reduce/Enlarge

Q Descreen

Q Saved Settings

Click on this or the other tab menus to view and change any scanning
parameters.
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4.  Copying

This section describes copying on your Xerox WorkCentre. It includes the
following topics:

Page

Features ......................................................................... 36
Making a single Copy...................................................... 37
Using the Copy Menu Features....................................... 38
Adjusting Resolution ....................................................... 38
Adjusting Contrast or Color Intensity ............................... 38
Selecting Media Type...................................................... 39
Setting Special Copy Features........................................ 39
Enlarging or Reducing the Image.................................... 40
Choosing Color or B&W Mode ........................................ 40
Using the Menu Button.................................................... 41
Changing the Number of Copies ..................................... 41
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Features

Your WorkCentre is a high quality copier that offers the following features:

Q Adjustable Resolution – improves the clarity and sharpness of your
copies.

Q Adjustable Contrast – obtains the best copy quality for documents
containing faint markings or dark images.

Q Selectable Paper Type – obtains the best copy quality for transparency,
glossy paper, coated paper or plain paper.

Q Clone – multiple images can be printed on one sheet with this feature.

Q Autofit – allows you to reduce or enlarge the original to fit the paper you
are using.

Q Enlarge/Reduce – reduces or enlarges the copied image from 25% to
400% of the original document.

Q Multiple Copies – 1 to 50 copies of the document can be made.

Q B&W/Color Mode Selection – allows you to select colour mode for a
color document.

Download from Www.Somanuals.com. All Manuals Search And Download.



Copying 37

Making a single Copy

Follow this procedure when you need to make a single copy of your original
document.

1 Make sure the WorkCentre is powered on. Load paper in one of the
paper feeders. The Display should show the message   001  .

2 Open the platen cover. Make sure the
glass is clean. Load the document on
the document glass facing down and
pushed against the left and rear
guides.

3 Close the platen cover.

NOTE:: If you do not close the platen cover or the document is not
evenly in contact with the document glass, scanning quality will be
severely reduced.

4 Press the Start button. The machine will make one copy with the
following features:

O Normal resolution

O Normal contrast

O Plain paper type

O 100% copy size (same as original)

O Single copy

O Color mode

5 For other copy features and functions, see the next section Using the
Copy Menu Features.
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Using the Copy Menu Features

This section describes all the WorkCentre features available for copying. Use
the copy menu buttons to change feature settings before pressing the Start
button to begin copying. When you press a feature button, the light
corresponding to the icon selected will turn on. To select the next option,
press the feature button again.

Adjusting Resolution
Each time you press the Resolution button, you can choose Best, Normal
or Draft mode.

Best mode is good for documents with fine detail. The
copy quality is very good but the copy speed is slow.

Normal mode works well for normal documents (text).

Draft mode can be used for fast copying with lower
resolution.

Adjusting Contrast or Color Intensity
In black and white mode, the Contrast button can adjust the contrast for a
document containing faint markings or dark images. In colour mode, the
Contrast button adjusts the color intensity.

Low contrast is good for documents containing dark
images.

Normal contrast works well with standard documents.

High contrast works well with light print or faint pencil
markings.
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Selecting Media Type
Press the Media Type button to select the desired media type.

Transparency

Glossy paper

Coated paper

Plain paper

NOTE: Transparencies may be smeared if you store the
transparencies in a humid area for a long time.

Setting Special Copy Features
You can set the following special features by pressing the Special Copy
button.

Clone Select Clone for automatically setting 
multiple image copies on a single page. 
The number of images is determined by 
the original image size. See NOTE.

Auto Select Auto to automatically reduce or 
enlarge the original image to fit it on the 
copy paper. See NOTE.

100% Select 100% to enlarge or reduce the copy
image size, then use the Scroll buttons to 
set the percent from 25% to 400%.

NOTE: When using Clone or Auto, the copy size cannot
be adjusted.
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Enlarging or Reducing the Image
You can reduce or enlarge the size of a copied image from 25% to 400% in
increments of 1% using the Copy Size/Scroll buttons.

% Button Press the Percent button to alternate 
between copy count and copy size 
in the Display.

25%>400% Press down the upper or lower Scroll
Copy Size/ button to increase or decrease image size
Scroll percent by 1% increments, or press and
Buttons hold to quickly decrease or increase the 

image size percent. Press Stop to reset 
the percent to 100%.

Choosing Colour or B&W Mode
Each time you press the B&W/Colour Mode button, Black&White and
Colour modes are alternatively selected.

Select the top icon for Black and White copying.

Select the bottom icon for Colour copying.
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Using the Menu Button
The Menu button provides a number of functions that let you manage
components of the WorkCentre. See Section 1 Getting Started/Using the
Menu Button for details.

Menu button

Changing the Number of Copies
You can set the number of copies from 1 to 50. The Control Panel Display
shows the selected number.

Press the Quantity button to increase the copy number.
The display recycles after 50. Press Stop to reset the
count to 001.

Download from Www.Somanuals.com. All Manuals Search And Download.



42 Copying

This page intentionally left blank.

Download from Www.Somanuals.com. All Manuals Search And Download.



Xerox Series User Guide 43

5.  Maintenance

This section describes maintenance procedures for the Xerox WorkCentre. It
includes the following topics:

Page

Managing the Ink Cartridges ........................................... 44
Tips for your ink cartridges .................................................. 44
Clean Print Head Procedure ............................................... 44
Wiping the Ink Cartridge Nozzles and Contacts.................. 47
Cleaning the Cartridge Carrier Contacts ............................. 48
Replacing the Ink Cartridge................................................. 49
Cartridge Alignment............................................................. 51

The Xerox WorkCentre Control Program......................... 54
Starting the Xerox WorkCentre Control Program................ 54
Xerox WorkCentre Control Program Tab Menus ................ 55

Cleaning the Scanning Glass .......................................... 56
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Managing the Ink Cartridges

Tips for your ink cartridges
To get the maximum benefit from your ink cartridges:

Q Do not remove an ink cartridge from its packaging until you are ready to
install it.

Q Do not refill the ink cartridge. The warranty will not cover damage caused
by using refilled cartridges.

Q Store the ink cartridge in the same environment as the printer.

Q Do not remove an ink cartridge from the printer except to replace it.
Immediately replace the ink cartridge or store it in the storage unit. The
ink cartridge will not print correctly if removed from the machine and left
exposed to air for an extended period.

Q Do not swap the colour cartridge with the black cartridge. The colour
cartridge should be installed in the Left carrier and the black cartridge
should be installed in the Right carrier.

Q If you have an opened ink cartridge you are not currently using and do
not have an available print cartridge storage unit, store it in an airtight
plastic bag. Do not leave it exposed to the air for an extended period; this
promotes drying out and clogging of the print nozzles.

Clean Print Head Procedure
You should test the print cartridge when the print is not clear or image
information is missing. The problem may be caused by blocked nozzles on
the ink cartridge.

This procedure cleans the ink cartridge by purging the nozzles. Then it prints
a test so you can see the results.

Use the procedure:

Q When you suspect the nozzles are clogged.

Q When characters are not printing completely.
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Cleaning the Print Head Nozzles From the Control Panel

This procedure cleans the print nozzles and removes any deposits that may
impair printing functions.

To run the procedure:

1 Press the Menu button repeatedly until the code   U04   appears in the
Display. Ensure there is paper in the Automatic Paper Feeder.

2 Press Start.

The WorkCentre prints a head cleaning test pattern.  Notice the series of
diagonal lines across the top and bottom of the test pattern. Breaks
within a line of the same color indicate a clogged nozzle. Try running this
procedure again if you see breaks in the diagonal lines. If the print quality
is satisfactory after running the test three times, the print nozzles are
clean.

If the print quality of the test pattern is still not satisfactory, go to step 3.

3 Remove and reinstall the print cartridge.

4 Repeat the Print Head Nozzle procedure.

5 If the diagonal lines are still broken, wipe the print cartridge nozzles. See
Wiping the Print Nozzles and Contacts.
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To clean the Print Head Nozzles from your PC:

In Windows 95/98 or Windows NT 4.0:

1 Go to Start>Programs>Xerox WorkCentre XK Series. Ensure there is
paper in the Automatic Paper Feeder.

2 Select Xerox WorkCentre Control Program on LPT1.

3 The Control Program window opens.

NOTE: For Windows 3.1: At system startup, open the Xerox WorkCentre
group from Program Manager. Double-click on the Xerox WorkCentre
Control Program icon.

4 Click the Cartridges tab, then click Clean Print Nozzles. The printer
feeds a sheet of paper and prints the nozzle test pattern.

NOTE: There are minor differences in the appearance of the Cartridges
Tab between Windows 95/98 and Windows NT 4.0

Examine the test pattern. Compare the diagonal same-color lines at the
top and bottom of the test pattern. Look for a break in the diagonal lines;
a broken line shows clogged nozzles.

If the bottom line shows improvement, rerun this test. If improvement
continues, rerun the test. If all nozzles are not printing after running the
test three times, continue with step 5.

5 If print quality does not improve, remove and reinstall the ink cartridge.
Repeat the Print Head Nozzle procedure.

6 If the line is still broken, wipe the nozzles and contacts. Refer to Wiping
the Ink Cartridge Nozzles and Contacts.
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Wiping the Ink Cartridge Nozzles and Contacts
If print quality does not improve after repeating the Print Head Nozzle
procedure, the problem may be caused by dried ink on the ink cartridge:

Q nozzles

Q contacts

Q carrier contacts in the printer

Follow this procedure:

1 Lift the scanner module. Lift the cartridge compartment lid/support up so
the scanner module rests on the top edge of the lid/support.

2 Press Menu until the code   U01   appears in the Display.

3 Press Start. The cartridge carrier assembly will move into the open area.

4 Remove the ink cartridge. See Replacing the Ink Cartridge.

5 Use a clean, lint free cloth, dampened with distilled water only, to gently
clean the entire copper colored area, including the nozzles and contacts.
To dissolve any dried ink, hold the damp cloth against the nozzles for
about three seconds. Gently blot and wipe dry.

NOTE: If you are cleaning a color ink cartridge, be especially careful to
wipe the nozzles in only one direction so the colors do not mix.

6 Allow the copper-colored area to dry, then reinstall the ink cartridge

7 Close the cartridge compartment lid/support and scanner module.

8 Repeat the nozzle test. See Cleaning the Print Nozzles.

9 If the line is still broken, clean the print cartridge carrier contacts in your
machine. See Cleaning the Cartridge Carrier Contacts.

10 If print quality still has not improved, replace the ink cartridge.
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Cleaning the Cartridge Carrier Contacts

1 Lift the scanner module. Lift the cartridge compartment lid/support up so
the scanner module rests on the top edge of the lid/support.

2 Press the Menu button until the code   U01   appears in the Display.

3 Press Start.

4 Unplug the power cord from the rear of the WorkCentre.

5 Remove both ink cartridges.

6 Use a CLEAN, LINT FREE, DRY CLOTH to clean the ink cartridge
carrier contacts on the back wall of the carrier.

7 Reinstall the ink cartridges.

8 Close the cartridge compartment lid/support and the scanner module.

9 Plug the power cord into the WorkCentre.

10 Test the ink cartridges by running the Clean Print Head procedure. If the
print quality is still unacceptable, contact your local Xerox Helpline.
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Replacing the Ink Cartridge
The ink cartridge includes the ink supply and the print head. Each time you
replace the ink cartridge, you are replacing the print head as well.

When you notice the print becomes light or one of
the low ink Diagnostic Display turns on, replace your
cartridge.

NOTE: When either of the two ink cartridge
Diagnostic Display turns on during PC printing, the
machine continues printing. After PC printing is
completed, replace the ink cartridge. Your machine
counts ink droplets, and keeps ink low counts for
both ink cartridges.

To replace the ink cartridge, perform the following steps:

1 Load paper into the Automatic Paper Feeder.

2 Lift and open the entire scanner module. Support the scanner with the
cartridge compartment lid/support.

3 Press the Menu button. A   U01   message will appear in the Display.

4 Press Start. The cartridge assembly will move to the open change area.

5 The LCD window will display the   L-C   message. If you want to change
the left cartridge (color) press Start, otherwise press Stop. The message
will then change to message   r-C  . If you want to change the right
cartridge (black), press Start, otherwise press Stop.

6 Pull the handle of the ink cartridge(s) you want to replace toward you
until there is a click. Remove the ink cartridge(s).

7 Remove a new ink cartridge from its packaging and carefully remove the
tape covering the print head. Hold the ink cartridge by the colored tab or
black areas only. Do not touch the copper area.

 �

Color Black
Diagnostic Display LEDs
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8 Insert the ink cartridge in the cartridge holder, then push the ink cartridge
firmly to the rear of the machine until it clicks into place.

If the ink cartridge moves loosely in the carrier, it has not clicked into
place. Repeat this step.

9 If you changed the left cartridge (colour) press Start, otherwise press
Stop. The message will then change to   r-C  . If you changed the right
cartridge (black) press Start, otherwise press Stop.

If you pressed Start to either of the two LED messages, the alignment
procedure will start. An alignment test pattern sheet will print during
which time the  display will show   L-P  .

10 Close the cover and proceed to the Cartridge Alignment procedure. Use
that particular procedure named To Align the Cartridge Using the
WorkCentre Control Panel, starting with step 4.

NOTE: If you are interrupted and leave the print carrier in the left side access
location for more than 30 minutes, the print cartridge carrier moves to the
right hand standby position.
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Cartridge Alignment
You should print the cartridge alignment test if vertical lines or characters
appear crooked. The cartridge alignment test will straighten the vertical lines.

To Align the Cartridge from your PC:

1 Open the Xerox WorkCentre Control Program on LPT1. Refer to Starting
the Xerox WorkCentre Control Program and to Using the Cartridges Tab.

2 Click Align Cartridges.

3 The printer feeds a sheet of paper and prints the alignment test pattern.

4 Examine the test print.

If the vertical lines are straight, no adjustment is needed.

If the lines are not straight, select the number in which the lines appear
the straightest and click OK.

To Align the Cartridge Using the WorkCentre Control Panel:

1 Press the Menu button on the Control Panel repeatedly until the
Message Code   U02   appears in the Display.

2 Press Start.

NOTE: The machine will time out after one minute if Start is not pressed,
and will return to Standby Mode. The Display will then show   001  .
Press Menu repeatedly until you see the code   U02   displayed, then
press Start to repeat the cartridge alignment process.

3 An alignment test pattern sheet will print during which time the Display
will show   L-P  . Review this sheet in response to the next series of six
Display messages.

�
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The alignment sheet looks like the following example:

4 For the first alignment message, the Display will show “A” plus a number,
as,   A15  . Look this number up on the alignment sheet. If the printed
lines associated with this number are aligned better than any of the other
printed lines in group “A”, press the Start button. If there is another set of
printed lines that is aligned better, press one of the Scroll buttons until
the number associated with the best aligned set appears in the Display.
Press Start.

�
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5 The Display will show the next number in the series, from “B” through
“F”. Repeat step 4 for these remaining five steps.

6 The Ink Cartridge alignment is completed. The Display will return to
showing   001  .
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The Xerox WorkCentre Control Program

In addition to the printer driver, the printer software also includes the Xerox
WorkCentre Control Program. The Control Program contains setup options
that define the operation of your machine.

The Control Program includes five tabs:

Q Status - Displays the printer status, ink levels, and print job status

Q Options - Includes setup options

Q Cartridges - Installs, cleans, or aligns the cartridge

Q DOS Printing - Includes settings for printing directly from DOS

Q About - Displays the Control Program version

NOTE: Select the tab menu Help button for online help with tab menu terms
and parameters.

Starting the Xerox WorkCentre Control Program

Windows 95/98 and Windows NT 4.0

1 Select Start>Programs.

2 Choose Xerox WorkCentre XK Series from the program list.

3 Select Xerox WorkCentre Control Program. The Xerox WorkCentre
Control Program window opens.

Windows 3.1x

1 From the Program Manager at system startup, open the Xerox
WorkCentre XK Series group.

2 Double-click on the Xerox WorkCentre Control Program icon. The Xerox
WorkCentre Control Program window opens.
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Xerox WorkCentre Control Program Tab Menus
When the Xerox WorkCentre Control Program on LPT1 window opens,
click the appropriate tab for the options you want to display. On the
appropriate tab, specify your changes. Click Close when you are done. Click
Help on any of the tabs to use the online Help feature.

Using the Status tab

This tab shows the printer status, ink levels, and print job status. The Status
tab includes these buttons:

Q Cancel Print – select this to cancel your print job.

Q Pause – select this to temporarily interrupt your print job. Select again to
restart the print job.

Q Print Test Page – select this to print a sample page.

The information area displays which job is printing, page and copy counts,
printing time, any alert/error messages and status. See graphic example
above that shows print job progress at 39% and a print time of 35 seconds.
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Cleaning the Scanning Glass

Carefully wipe the scanning glass with a SOFT, DRY CLOTH. If the glass is
very dirty, first wipe it with a slightly dampened cloth, then with a dry cloth.
Be very careful not to scratch the glass surface.

CAUTION: Never spray liquid directly onto the scanning glass.
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6.  Troubleshooting

This section describes WorkCentre troubleshooting for the following problem
areas and messages:

Page

Clearing Jams................................................................. 58
Paper Jams While the WorkCentre is Printing .................... 58
Tips for Avoiding Paper Jams ............................................. 59

Display Error Codes........................................................ 60
Printer Problems ............................................................. 61
Print Quality Problems .................................................... 64
Paper Feeding Problems ................................................ 69
Scanning Problems ........................................................ 71
Diagnostic Display on the Control Panel ......................... 72
General Tips ................................................................... 73

Installation ........................................................................... 73
Performance........................................................................ 73
Customization...................................................................... 73

Status Message Codes on the Control Panel.................. 74

Refer to the specific subsection for a description of the problem and
associated solutions.
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Clearing Jams

Paper Jams While the WorkCentre is Printing
By carefully selecting the correct paper type and loading them properly, you
should be able to avoid most paper jams. If paper jams occur, an error
message   E01   appears in the Display and the paper jam Diagnostic
Display icon lights up on the Control Panel. Follow the steps below to clear
jam. To avoid tearing paper, pull the jammed paper out gently and slowly.

If Paper is Jammed in the Paper Feed Area at the Rear of the WorkCentre

1 Remove the stack of paper (if necessary).

2 Remove the jammed paper by gently
pulling it straight up as shown in the
graphic.

3 After you remove the jammed paper,
reload the stack of paper back into
the Automatic Paper Feeder with the
print side facing you.  Before loading,
ensure the edges of the stack of
paper are even and straight.

4 Adjust the paper guide to match the width of the paper.

5 Press Stop.

If Paper is Jammed in the Printer Output Area

If the paper jams as it moves to the
printer exit tray, remove the jammed
paper by pulling gently on the paper as
shown in the graphic and then press
Stop.
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Tips for Avoiding Paper Jams
By carefully selecting print materials and loading them properly, you should
be able to avoid most paper jams. If jams do occur, follow the steps outlined
in Clearing Jams.  If jams occur frequently, make sure that you are following
these tips to avoid jams.

Q Follow the procedures in Loading Paper to load paper properly. Make
sure the adjustable paper guides are positioned correctly.

Q Do not overload the paper. Never exceed the maximum capacity of 100
sheets of paper in the Automatic Paper Feeder.

Q Flex, fan, and straighten paper before loading it.

Q Do not load wrinkled, creased, damp, highly curled, or previously stapled
paper.

Q Do not mix paper types.

Q Use only recommended print paper. See Section 1 Getting Started/Paper
Guidelines

Q Ensure that the recommended print side is facing up when loading paper
into the feeder.

Q Store print materials in an acceptable environment.

NOTE: If the remedies described above do not eliminate the error code in the
Display and you are sure that no paper remains in the paper path, do the
following:

Turn off the power switch, pull the power cord from the wall outlet, wait for at
least one minute, then insert the power cord back into the wall outlet. Turn
the power switch on. The machine should be at the normal standby mode.
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Display Error Codes

The following error codes appear in the Control Panel Display when your
machine has a problem. Use it to identify and solve problems.

LED Meaning Solution

  E01  . Paper is jammed
inside the unit, or
the paper feeder is
empty.

Q Remove jammed paper from
the paper feeder or the paper
exit tray, and press Stop.

Q If there is no paper in the
paper feeder, load and press
Stop.

Q If there is paper in the paper
feeder, remove the paper, then
reload paper and press Stop.

  E02  . No left cartridge Install the colour ink cartridge.
See Installing the Ink Cartridges.

  E03  . No right cartridge Install the black ink cartridge. See
Installing the Ink Cartridges.

  E04  . One of the ink
cartridges is not
installed correctly.
See CAUTION.

Push each ink cartridge firmly
toward the back of the machine
until it clicks into place and press
Stop.

  E05  . One or both
cartridges are not
in good condition.

Q Align the ink cartridges. See
Aligning the Ink Cartridges.

Q Clean the cartridge nozzles
and contacts. See Wiping the
Print Nozzles and Contacts.

Q Replace the ink cartridges.
See Replacing the Ink
Cartridge.

CAUTION: Non-Xerox ink cartridges will not fit correctly into the
WorkCentre cartridge compartment.
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Printer Problems

Symptom Cause and Solution

The printer does not
print.

Q The USB or parallel cable is not
connected properly.

Q The USB or parallel cable is defective.
Swap the cable with one known to work.
If necessary, replace the cable.

Q If using a parallel cable, ensure that it is
compliant with the IEEE 1284 standard.

Q The printer port is configured incorrectly.
Check Printer Setting in Windows to
make certain that the print job is being
sent to the correct port (for example,
LPT1).

Q A paper jam has occurred.  See Section
6 Troubleshooting/Clearing Jams.

Q The printer may be configured incorrectly
within the PC application.  Check the
application to verify that all print settings
are correct.

Q Q The printer driver may be
incorrectly installed.  Remove the
existing printer driver, and re-install the
printer driver. See Section 1 Getting
Started/Uninstalling Software.  Try
printing a test page.

The paper does not feed
into the printer.

Q Paper has not been loaded properly.
Remove and re-insert the paper
correctly. See Section 1 Getting
Started/Loading Paper.

Q There is too much paper in the Automatic
Paper Feeder. Remove some paper.

�
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Printer Problems (continued)

Symptom Cause and Solution

Part of the printed page
is blank.

Q The page layout is too complex. Simplify
the page layout, and remove any
unnecessary graphics from the
document.

Q The page orientation setting may be
incorrect in the print driver. Change the
page orientation in the Print Setup dialog
box.

Q The paper size and the software paper
size settings do not match. Load the
correct paper in the printer or change the
software paper size settings in the Print
Setup dialog box.

Q Scaling may be set to less than 100%.
Change the scaling setting in the
Paper/Output dialog box.

Q The printer cable may be incorrect.
Replace the cable with a correct cable.
See Section 1 Getting Started/Setup.

Q One of the ink cartridges may be empty.

The printer prints the
wrong data, or it prints
incorrect characters.

Q The printer cable may be connected
improperly. Check the cable connection.

Q There may be a problem with the printer
driver software. Exit Windows and reboot
the computer. Turn the printer off and on.

Q The printer cable may be incorrect.
Replace the cable with a correct cable.
See Section 1 Getting Started/Setup.

�
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Printer Problems (continued)

Symptom Cause and Solution

The paper constantly
jams.

Q There is too much paper in the Automatic
Paper Feeder. Remove some of the
paper.  If printing onto transparencies or
labels, insert them one at a time in the
Manual Paper Feeder.

Q An incorrect type of paper is being used.
Use only paper that meets the
specifications required by the printer.
See Section 1 Getting Started/Paper
Guidelines.

Q The paper setting method may be
incorrect.  If printing onto envelopes,
insert the envelopes so that there is a
gap of approximately 1 mm between the
left and right edges of the envelopes at
the paper guide.

Printing is too slow. Q If using Windows 3.1, Print Manager may
be disabled. From the Control Panel
Printers menu, check the Use Print
Manager box.

Q If using Windows 3.1, the Background
Printing item in the Option menu of Print
Manager may be set incorrectly. Select
Background Printing from the Option
menu in the Print Manager.

Q If using Windows 95/98/NT 4.0, the
Spooling Setting may be set incorrectly.
Select Start > Settings > Printers. Click
the WorkCentre icon with the right mouse
button, select Properties, click the
Details tab, and then click the Spool
Settings button. Select the desired spool
setting from the available choices.
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Print Quality Problems

Symptom Cause and Solution

Light or blurred
characters.

Q You may be using Draft quality or Normal
quality mode.  Try using High 1200 dpi
print quality mode.

Q The print cartridge may be running out of
ink.  Replace the print cartridge.  The PC
Control Program Status Monitor shows
the amount of ink left in the cartridge.

Q Make sure you are using the correct type
of paper.  Try another type of paper. See
Section 1 Getting Started/Paper
Guidelines.

Q You may be printing on the wrong side of
the paper.

Q The print head may need cleaning.  See
Section 5 Maintenance/Print Head
Nozzle procedure.

Solid black areas on
transparencies contain
white streaks.

Try changing the fill pattern in your
application software. The print head may
need cleaning. See Section 5
Maintenance/Print Head Nozzle procedure.

Smudged or dark
characters.

Q Make sure you are using the correct type
of paper. Try another type of paper.
Make sure the paper is straight and
unwrinkled.

Q Let ink dry before handling the paper.
You can use ‘Dry Time Delay’ check box
in the print driver setting. Change the
Print Quality setting to Normal quality
mode. The print head may need
cleaning.  See Section 5
Maintenance/Print Head Nozzle
procedure.

�
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Print Quality Problems (continued)

Symptom Cause and Solution

Characters with white
lines

Q The print cartridge may be running out of
ink. Replace the print cartridge. The
Status monitor shows the amount of ink
left in the cartridge.

Q Remove and reinstall the print cartridge.
See Section 5 Maintenance/Replacing
the Ink Cartridge.

Q The print head may need cleaning.  See
Section 5 Maintenance/Print Head
Nozzle procedure.

Q If printing on transparencies, try changing
the fill pattern in your application
software.

Incorrect format or
characters do not align
correctly at left margin.

Q The media is incorrectly loaded or is an
unsupported size or type.  See Section 1
Getting Started/Paper Guidelines.  For
special media, it is recommended to feed
one sheet at a time.

Q Make sure you do not have hard-coded
spaces at the left margin in your
application.

Q The print head may need cleaning. See
Section 5 Maintenance/Print Head
Nozzle procedure.

Q The print cartridge may be mis-aligned.
See Section 5 Maintenance/Cartridge
Alignment.

�
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Print Quality Problems (continued)

Symptom Cause and Solution

Vertical straight lines are
not smooth in tables,
borders, and graphs.

The print cartridge may be mis-aligned.
See Section 5 Maintenance/Cartridge
Alignment.

Printed color does not
match screen colors.

Q The color print cartridge has run out of
one or more inks.  Install a new cartridge.
See Section 5 Maintenance/Replacing
the Ink Cartridge.

Q The print head may need cleaning. See
Section 5 Maintenance/Print Head
Nozzle procedure.

Black and white is
printing instead of
expected color printing.

Q The print settings may be incorrect.
Check Document Type setting in the
Document/Quality dialog in the print
driver.

Q A black cartridge may be installed
instead of a color cartridge.  Replace with
a color cartridge.  See Section 5
Maintenance/Replacing the Ink Cartridge.

�
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Print Quality Problems (continued)

Symptom Cause and Solution

Color print quality is
poor.

Q Ensure that you are using the correct
type of paper. See Section 1 Getting
Started/Paper Guidelines.

Q Ensure that the Media/Paper Type
setting in the print driver is correct for the
type of paper loaded.

Q Change the Print Quality setting in the
print driver to High or Normal

Printer power is on, but
nothing prints.

Q The printer is improperly connected to
the computer. Make sure the printer
cable is firmly connected to the printer
and the computer.

Q Make sure the printer cable is correct.
See Section 1 Getting Started/Setup.

Q Bad printer cable, or computer port. Try
another cable. See Section 1 Getting
Started/Setup.

Q Make sure your application has the
WorkCentre selected as the default
printer.

Printer seems to be
printing, but no
characters are printing.

Q Check the print cartridge.  Tape may be
covering the ink nozzles of the print
cartridge.

Q The print cartridge may be out of ink.
Replace with a new one.   See Section 5
Maintenance/Replacing the Ink Cartridge.
The PC Control Program Status Monitor
shows the amount of ink left in the
cartridge.

Q Clean the cartridge carrier contacts. See
Section 5 Maintenance/Cleaning Carrier
Contacts.

�
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Printer Quality Problems (continued)

Symptom Cause and Solution

Unexpected characters
are printed or characters
are missing.

Q Make sure your application has the
WorkCentre selected as the default
printer.

Q The printer cable may not be securely
connected to the printer and the
computer, or the printer cable may not he
correct type. Check the printer cable.

Q The print head may need cleaning.  See
Section 5 Maintenance/Print Head
Nozzle procedure.

Printer prints very
slowly.

Q You may be using High 1200 dpi print
quality. Change the Print Quality setting
in the print driver to Normal.

Q Graphics print more slowly than text.

Q Color prints more slowly than black.
Special media prints more slowly than
plain paper.

Q Another application currently open affects
print speed.  Close the running program if
not required.

Control panel of your
machine does not
respond.

1) Turn power switch off, then on. If this
does not work, try step 2.

2) Unplug the power cord, wait one minute,
then plug in the machine.

Page does not print. Simplify the page format or use fewer fonts.
Some complicated page formats may not
be printable on the printer. If you are using
too many fonts, or printing complex
graphics, you can experience this problem.
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Paper Feeding Problems

Symptom Cause and Solution

Paper is jammed during
printing.

Clear the paper jam.  See Section 6
Troubleshooting/Paper Jams While the
Machine is Printing.

Paper sticks together. Q Ensure there is not too much paper in the
Automatic Paper Feeder.  Depending on
the thickness of your paper, the feeder
can hold up to 100 sheets of paper.

Q Make sure you are using the correct type
of paper. See Section 1 Getting
Started/Paper Guidelines.

Q Remove paper from the feeder and flex
or fan the paper.

Q Humid conditions may cause some paper
to stick together.

Paper fails to feed. Q Make sure the envelope guide is not in
the upright position.

Q Remove any obstructions inside the
machine.

Multiple sheets of paper
do not feed.

Q Different types of paper may be stacked
in the Automatic Paper Feeder.  Load the
paper of only one type, size, and weight.

Q When loading paper, do not force the
paper down into the printer.

Q If multiple sheets have caused a paper
jam, clear the paper jam. See Section 6
Troubleshooting/Clearing Jams.

�
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Paper Feeding Problems (continued)

Symptom Cause and Solution

Paper skews or buckles Q Ensure there is not too much paper in the
Automatic Paper Feeder.  Depending on
the thickness of your paper, the feeder
can hold up to 100 sheets of paper.

Q Make sure the paper guide does not
cause the paper to bow in the Automatic
Paper Feeder.

Q Make sure you are using the correct type
of paper. See Section 1 Getting
Started/Paper Guidelines.

Q When loading paper, do not force the
paper down into the machine.

Q Make sure the right side of the paper is
aligned with the right edge of the feeder,
and the left paper guide is set against the
left side of the paper.

Q Make sure the envelope guide is not in
the envelope position.

Transparencies stick
together in the paper
exit.

Use only the transparencies specially
designed for an ink jet printer.  Remove
each transparency as it exits from the
printer.

Envelopes skew or fail to
feed correctly.

Q Ensure that the envelope guide has been
turned upright to the envelope load
position.

Q Ensure that the paper guide is against
the left side of the envelopes.
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Scanning Problems

Symptom Cause and Solution

The scanner does not
scan.

Q Make sure you place the document to be
scanned face down on the document
glass.

Q There may not be enough available
memory to hold the document you want
to scan. Try the Pre-Scan function to see
if that works. Try lowering the scan
resolution rate.

Q The USB or parallel cable is not
connected properly.

Q The USB or parallel cable is defective.
Swap the cable with one known to work.
If necessary, replace the cable.

Q If using a parallel cable, ensure that it is
compliant with the IEEE 1284 standard.

Q The scanner is configured incorrectly.
Check scanner setting in scanner driver
to make certain that the scanner job is
being sent to the correct port (for
example, LPT1).

The unit scans very
slowly.

Q Graphics are scanned more slowly than
text.

Q Communication speed becomes slow in
scan mode because of the large amount
of memory required to analyze and
reproduce the scanned image. Set your
computer to ECP printer mode through
BIOS setting.  It will help to increase the
speed. For details on how to set BIOS,
refer to your PC documentation.

�
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Scanning Problems (continued)

Symptom Cause and Solution

The following message
appears on the computer
screen: Scanner is busy
receiving or printing
data.  When the current
job is completed, try
again.

There may be a copying or printing job in
progress.  When the current job is
completed, try the job again.

Diagnostic Display on the Control Panel

There are three diagnostic conditions that may occur in the WorkCentre.
When any one of these Diagnostic Display LED lights turns on, refer to this
table.

LED Light Meaning Solution

The colour ink
cartridge has a
low ink supply.

Replace the colour ink cartridge.
See Section 5
Maintenance/Replacing the Ink
Cartridge.

The black
cartridge has a
low ink supply.

Replace the black cartridge. See
Section 5 Maintenance/Replacing
the Ink Cartridge.

A paper jam has
occurred inside
the machine or the
paper feeder is
empty.

Q Remove the jammed paper from
the paper feeder or the paper
exit tray, and press Stop.

Q If there is no paper in the paper
feeder, load paper and press
Stop.

Q If there is paper in the paper
feeder, remove the paper from
the feeder, the reload the paper
and press Stop.
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General Tips

Installation

 When installing the WorkCentre printer and scanner drivers, close all
open programs first.

 Improved results can be obtained by installing the WorkCentre drivers
and Control Program software first before you install the Pagis Pro and MGI
PhotoSuite software.

 Use a direct connection (single cable) between your PC and the
WorkCentre to avoid communications problems. Do not use an A/B printer
switch or a pass-through port (as, a zip drive).

Performance

 When running a memory intensive function (as, scanning), better and
faster results can be achieved by closing any open programs (as,
screensavers and other background applications.

 If any hangup or freeze-up occurs in the PC or WorkCentre, try
rebooting the PC or turning the WorkCentre off, then on (pulling the AC
power cord from the AC outlet, then re-inserting the cord).

 If a paper jam occurs, and the error code E01 does not clear after
removing the jam, pull the WorkCentre power cord from the outlet, wait one
minute, then plug the cord in again. The Display should show 001.

 If scanning does not work, try reducing the resolution rate.

 When using Clone for copying, if the number of images is not copied as
expected, the original image size may be too large. Try reducing the image
size before copying. Also try shifting the image document on the platen to
different locations (as, the home registration marks).

Customization

 To have the WorkCentre Control Program run in a minimized mode,
select Start>Programs>Xerox WorkCentre XK Series> Printer Control
Program>Options, then check “run minimized”.
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Status Message Codes on the Control Panel

The following codes provide information on the current status of the machine.
These codes appear in the Control Panel Display.

Mode Code Descriptions

Standby 001 Standby mode

025 to 400 Copy size (reduction. enlargement)Copy

001 to 050 Copy quantity

U01 Change cartridge

U02 Align cartridge. L-P appears in the Display as
the alignment sheet is printed.

A00 to A30 Horizontal alignment

b00 to b15 Vertical alignment

C00 to C30 Quick monochrome bi-directional alignment

d00 to d30 Quick color bi-directional alignment

E00 to E30 Normal monochrome bi-directional
alignment

F00 to F30 Normal color bi-directional alignment

U03 Set paper size:

P01 Letter

P02 A4

P03 Legal

Menu

U04 Ink nozzle self test/cleaning

PC Scan PCS Scanning has been initiated from PC

PC Print PCP Printing has been initiated from PC

L-C Left cartridge (color) changed?

r-C Right cartridge (black) changed?

Cartridge
change

6SYbsy The machine is busy. Replace the cartridge
after the current job is done.
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Appendix

Machine Specifications

Scanner

Item Specification

Operating System Windows 3.1x, Windows95/98/NT 4.0

Interface IEEE 1284 (ECP Support), USB (without
HUB Mode)

Compatibility TWAIN Standard

Device Platen Colour CIS (Contact Image Sensor)

Scan Width Maximum216 mm, Effective 210 mm

Color Depth Internal 30 bit, External 24 bit

Optical Resolution (H x V) 300 x 600 dpi

Interpolation Resolution Max. 4800 dpi

Pre-scan Mode Yes, 75 dpi

Minimum PC spec 486DX, 100 MHz, 16 MB memory, 20 MB
free disk space

Recommended PC spec Pentium II, 200 MHz, 32 MB memory, 20 MB
free disk space
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Printer

Item Specification

Technology Colour Thermal Inkjet

Engine Type 2-Pen (K and CMY)

Operating System Windows 3.1x, Windows 95/98/NT 4.0

Interface IEEE 1284 (ECP Support), USB (without
HUB Mode)

Emulation HBP (GDI)

Print Speed Mono < 8 ppm draft, 5 ppm normal

Colour < 3 ppm draft, 1.5 ppm normal

Print Resolution
(H x V)

Draft 300 x 600 dpi

Normal 600 x 600 dpi

Best 1200 x 1200 dpi (addressable)

Maximum Paper Size A4/Letter/Legal

Effective Printing Width 203 r 1 mm

Output Tray Capacity Maximum 50 sheets

Input Paper Capacity Maximum 100 sheets (20 lb. paper)

Maximum Printer Cable
Length

 1.8 m.

Minimum PC spec. 486DX, 100 MHz, 16 MB memory, 20 MB
free disk space

Recommended PC spec. Pentium II, 200 MHz, 32 MB memory, 20
MB free disk space
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Copier

Item Specification

Copy Mode Black and Color

Scanner Type Flat-bed without Automatic Document
Feeder

Maximum Original size A4/Letter

Maximum Paper Size A4/Letter/Legal

Maximum Scan Width 216 mm

Optical Resolution (H x V) 300 x 600 dpi

Copy Quality Draft, Normal, Best

Mono Copy Speed (A4) Draft: < 3 cpm, Normal: < 2 cpm

Color Copy Speed (A4) Draft: < 1.5 cpm, Normal: < 0.5 cpm

Effective Print-edge Margin Top: 3.4 mm,
Bottom: 19.05 mm,
Each side6.5 mm

Multicopy 50 pages

Reduction and Enlargement 25% to 400% (1% increments)

Fixed R/E Settings 100%, AutoFit, Clone (multiple images)

Contrast Control 3 steps

Ink Saver Mode Use Draft Mode

Auto Sensing Check Paper (paper jam or no paper),
Low ink
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General Specifications

Item Specification

Rated AC power input 110 to 240V AC

Average power
consumption

Under 15W (Standby)

Under 50W (Copy Mode)

Under 35W (Scan/Print Mode)

Machine Size 44 x 46 x 21 cm.

Machine Weight 8.25 kg. (machine without paper)

Operating Condition Temperature 5o to 40o C
(40o to 104o F)

Recommended
Operating Condition

Temperature 16o to 32o C

Humidity 40% RH to 70% RH

Inkjet Cartridge Part
Numbers

Colour  #8R12591 Black #8R7881
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Media Specifications

Sizes

Type Width x Length
(mm x mm)

Letter 216 x 279

Legal 216 x 356

B5 182 x 257

A4 210 x 297

Executive 184 x 267

A5 148 x 210

A6 Card 105 x 148

Post Card 4x6 102 x 152

Index Card 3x5 76 x 127

Hagaki 100 x 148

Envelope 7 ¾ 98 x 190

Envelope 9 98 x 225

Envelope 10 105 x 241

Envelope DL 110 x 220

Envelope C5 162 x 229

Envelope C6 114 x 162

Envelope B5 176 x 250

Baronial 143 x 111

Custom 76.2 to 215.9 x

127.0 to 355.6

Download from Www.Somanuals.com. All Manuals Search And Download.



Appendix80

Media Specifications (continued)

Feeding by Media Type

Paper Type Feeding Method

Normal copying paper Auto Feed

Inkjet Paper Auto Feed

Transparency Auto Feed

Coated paper Auto Feed

Label Manual Feed

Envelope Auto Feed (use envelope guide)

Ordinary card Auto Feed (use envelope guide)

T-shirt paper Manual Feed

Ordinary postcard Auto Feed (use envelope guide)

The following media types are unusable:

Q Erasable bond paper

Q Synthetic paper

Q Thermal reactive paper

Q Multi-paged paper

Q Embossing paper

Q Envelopes with cutting lines, perforated paper, embossed paper,
contents or self-adhesive envelopes.

Q Label paper with slick back

Q Auto Feed media weights greater than:

O 90 gsm. for paper and envelopes

O 150 gsm for card stock
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Certifications

Radio Frequency Emissions

Europe

The CE marking applied to this product symbolises Xerox Europe Declaration of
Conformity with the following applicable Directives of the European Union as of the dates
indicated.
January 1, 1995: Council Directive 73/23/EEC amended by Council Directive 93/68/EEC,
approximation of the laws of the member states related to low voltage equipment
January 1, 1996: Council Directive 89/336/EEC, approximation of the laws of the member
state related to electromagnetic compatibility.
This equipment has been tested and found to comply with the limits for a Class B digital
device.  These limits are designed to provide reasonable protection against harmful
interference in a residential installation.  This equipment generates, uses and can radiate
radio frequency energy and, if not installed and used in accordance with the instructions,
may cause harmful interference to radio communications.  However, there is no
guarantee that interference will not occur in a particular installation.  If this equipment
does cause harmful interference to radio or television reception, which can be determined
by turning the equipment off and on, the user is encouraged to try to correct the
interference by one or more of the following measures:
Reorient or relocate the receiving antenna.
Increase the separation between the equipment and the receiver.
Connect the equipment into an outlet on a circuit different from that to which the receiver
is connected.
Consult the dealer or an experienced radio/TV technician for help.
A full declaration,defining the relevant directives and referenced standards can be
obtained from your Xerox representative or by contacting:

Xerox Europe Product Safety,
Xerox Europe Technical Centre,
PO Box 17,
Bessemer Road,
Welwyn Garden City,
Herts AL7 1HE, England.

This system is certified manufactured and tested in compliance with strict safety and
radio frequency interference regulations.  Any unauthorised alteration which includes the
addition of new functions or the connection of external devices may impact this
certification.  Please contact your local Xerox Europe representative for a list of approved
accessories.In order to allow this equipment to operate in proximity to industrial, scientific
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and medical (ISM) equipment, the external radiation from the ISM equipment may have
to be limited or special mitigation measures taken.

Download from Www.Somanuals.com. All Manuals Search And Download.



Appendix 83

Energy Star

This printer contains advanced energy conservation technology which reduces power
consumption when it is not in active use.
When the printer does not receive data for an extended period of time, power
consumption is automatically lowered.
The energy star problem does not represent EPA endorsement of any product or service.
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Index

33
3-hole paper, 14

AA
About, 29, 54
Alert, 55
Alignment, See Ink cartridge:align
Alignment sheet, 13, 52, 74
APF. See Automatic Paper Feeder
Application, 15, 16, 24, 26-28, 61, 64, 65, 67, 68
Automatic Paper Feeder, 1, 3, 8, 11, 13-16, 45,

46, 49, 58, 59, 61, 63, 69, 70, 80

BB
Bi-directional, xii, 9, 74

CC
Cable, xii, 2, 9, 61, 62, 67, 68, 72
Calling for Service and Supplies, ix, 2
Cancel, 7, 55. See also Stop
Cartridge. See Ink cartridge
Cartridge alignment. See Ink cartridge:aligning
Cleaning the Scanning Glass, 43, 56
Closure Button

Cancel, 7, 29, 55
Help, 22, 29, 54, 55
OK, 23, 26, 29, 32, 51

Colour, ix, 6, 27-29, 35-38, 40, 67, 68, 75-78
Intensity, 35, 38

Components, 1, 2
Configuration, xii
Contrast, 5, 35, 36, 38, 77
Control Locations, 1, 3, 4
Control Panel, 1, 3-5, 10, 11, 15-18, 27, 41, 45,

50, 51, 57-60, 63, 73, 74
Control Program, xii, 11, 22, 26, 43, 46, 51, 54, 55,

64, 67
Copies, 6, 29, 35, 36, 39, 41

Copy, x, 6, 13, 35, 37-40, 74, 77
Making One Quick Copy, 35, 37

Custom, 79

DD
Default, 28, 29

Printer, 23, 26, 27, 67, 68
settings, 7, 29

Diagnostic Display LEDs, 5, 49, 57, 72
Display, 2, 3, 5-7, 10-14, 17, 18, 26, 32, 33, 37,

40, 41, 45, 47-49, 51, 52, 53, 57-60, 73, 74
Documentation, 9, 22, 26, 71
DOS, 26, 54

EE
Editor, xii, 33
Enlarging, 35, 40
Envelopes, 14, 15, 19, 63, 70, 79, 80
Error, 6, 10, 14, 55, 58-60, 72

Codes, 57, 60
Exit, 8, 29, 58, 60, 62, 70, 73
Exit tray, 8, 58, 60, 73
Extender, 8

FF
FCC, 81
Feeder. See Automatic Paper Feeder or Manual

Paper Feeder
File, 23, 26, 28, 32
Finishing, 28, 29
Fixed, 77
Fold, 14
Folder, 28, 29
Font, 68
Format, 65, 68
Function, xii, 17, 31, 32, 33, 37, 41, 45, 71

GG
GDI, 76
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HH
Help, 8, 54, 71, 81. See also Closure Button
Helpful Hints, viii . See also Tips
Horizontal, 74

II
IEEE 1284, xii, 4, 9, 61, 72, 75, 76
Image, xii, 5, 29, 33, 34, 36, 39, 40, 44, 71
Index, 79
Ink cartridge, ix, xii, 1, 2, 4, 10-13, 17, 43, 44, 46-

50, 53, 60, 62, 65-67, 73
aligning, 1, 10, 11, 17
changing, 17
cleaning, v, viii, 7, 17, 43, 45, 47, 48, 64-66,

68, 74
install, 11
replace, 49

Insert, 12, 23, 50, 72
Installation, vi, xii, 1, 11, 22, 23, 44, 81
Intensity, 35, 38
Iron-on. See Paper:iron-on

JJ
Jams. See Paper jams
Job, 28, 29

LL
Label, 80
Landscape, 14
LED Window. See Display
Limit, 81
Loading

envelopes, 1, 15
paper, 1, 14, 59, 61

LPT1, 46, 51, 54, 55, 61

MM
Machine Specifications, 75
Maintenance, 11, 13, 17, 18, 22, 26, 43, 64-68, 73
Manual Feed, 80
Manual Paper Feeder, 1, 3, 14, 16, 63
Margin, 77
Media, viii, 1, 5, 14, 15, 16, 19, 21, 39, 65, 67, 68,

79, 80
Specifications, 79, 80
Type, 5, 39, 80

Memory, 71, 75, 76
Menu

button, 11, 17, 18, 41, 45, 48, 49, 51
Features, 35, 37, 38

Message. See Status:Message Codes
Model, ix, xi

Mouse, 28, 63

OO
Open, 8, 11, 37, 51, 59
Owner, x

PP
Paper, 1, 3, 5-8, 11, 14-21, 26, 27, 29, 36, 37, 39,

45, 46, 49, 51, 58-64, 67, 68, 69, 70, 73, 74, 77,
78, 80

coated, 5, 20, 21, 80
glossy photo, 1, 21
greeting card, 20
guidelines, 1, 19, 59, 63-65, 67, 69, 70
iron-on, 20
jams, 57, 58, 59, 69

avoiding, 57, 59
Selection, 1, 20
Size, 1, 18, 76, 77. See also Media

Specifications
Paper Specifications. See Media Specifications
Parallel, xii, 9, 61, 72
Parameter, 29
Part numbers, ix, 78
Pause, 55
Port, xii, 4, 9, 10, 29, 61, 67, 72
Portrait, 14, 20
Position, 50, 69, 70
Postcard, 80
Print

driver, xii, 22, 23, 26, 27, 29, 32, 33, 34, 54,
61, 62, 64, 66-68

job, 15, 16, 26, 27, 29, 54, 55, 61
Quality, 57, 64-68
Test Page, 55

Printer
Properties, 25, 29
Settings, 25-28

Printing, 21, 25, 26, 54, 57, 58, 63, 69, 74, 76
Problem, 14, 44, 47, 57, 60, 62, 68, 72

paper feeding, 57, 69, 70
print quality, 57, 64-67
printer, 57, 61, 62, 63
quality, 57, 64-68
scanning, 57, 71, 72

RR
Reducing. See Enlarging
Registration, xi
Relative, 21
Remedy, 59
Replacing ink cartridge, See Ink cartridge:replace
Requirement, v, xii
Resolution, 5, 33-38, 71, 75-77
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SS
Safety Notes, v, vi, vii
Save, xi, 33

As, 33
scaling, 62
Scanner, xii, 3, 4, 11, 12, 17, 22, 31-34, 43, 47,

48, 49, 56, 57, 71, 72, 74, 75, 77
Selecting Media Type, 39
Service, ix, 2, 48
Setting paper size, 17
Settings, 7, 25, 26-29, 34, 38, 54, 61-63, 66, 77

Special Features, 35
Setup, 1, 8, 10, 23, 26, 28, 54, 62, 67
Size, 1, 6, 13, 18, 40, 76, 77, 78. See also

Paper:Size
Software, 1, 22, 24, 26, 61

installation, 1, 22, 26, 32
Specifications, 19, 75, 78-80
Status, 6, 54, 55, 74

Message Codes, 57, 74
Stop, 7, 12, 40, 41, 49, 60, 73
Supplies, 2

TT
Test, 7, 13, 17, 20, 44-48, 51, 55, 61, 74

Page, 55
print, 51

Timeout, 29

Tips, 73
Transparencies, 14, 20, 39, 63-65, 70, 80
Troubleshooting, 57
T-shirts. See Paper:iron-on

UU
Uninstall, vi, 8, 21, 24, 29, 44, 46, 49, 58-60, 62,

72, 73

VV
Version, 29, 54
Vertical, 66, 74

WW
Windows 3.1x, xii, 23, 24, 27, 28, 54, 75, 76
Windows 95/98, xii, 23, 25, 27-29, 46, 54, 63, 76
Windows NT 4.0, 25, 27, 28, 46, 54
www.xerox.com, ix

XX
Xerox, vii, viii, ix, xi, xii, 2, 22, 25, 26, 28, 31, 32,

35, 43, 46, 48, 51, 54, 55, 81
Xerox SupplyNet, ix
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